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1 Conventions and Trademarks

1.1 Typographic conventions

A Key A at the keyboard.

Ctrl-A Control key. Hold down Ctrl key and A simultaneously.
Q@ Icon in toolbar.

*.mat Filename extension.

C:/Program Folder.

File Menu, e.g. File menu.

File—Save As  Sub menu, e.g. under the File menu the item Save As is found.

Close Push/Toggle button in the graphical user interface.
® Endocardium‘ Radiobutton in the graphical user interface.

X Single frame | Checkbox in the graphical user interface.
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2 Requirements

2.1 System requirements
e Operating System: 64-bit Windows 10
e Computer with 8 GB of memory or preferably 16 GB
e Harddisk with at least 5 GB of available space
e Graphics card supporting both DirectX and OpenGL

To access full version of machine learning algorithms in Segment:
e CUDA enabled NVIDIA graphics card with 4 GB memory or more
— GPU architecture: Ampere, Turing, Volta, Pascal

For users with additional modules not included in the free research version:

e Internet connection for software license management and software download. We rec-
ommend a speed of at least 24 Mbit/s.

Recommendations

e Systems with two screens

e Using SSD disk for reading data

2.1.1 Mac OS users
Please refer to the section "I have a Mac" in our FAQ (www.medviso.com/faq).

2.2 Safety Instructions

Caution used with the safety alert symbol, indicates a hazardous situation which, if not
avoided, could result in minor or moderate injury or material damage. Caution consists of
the following elements:

e Information about the nature of a hazardous situation,
e Consequences of not avoiding a hazardous situation, and

e Methods of avoiding a hazardous situation.

The following cautions are valid for Segment:
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2.2 - SAFETY INSTRUCTIONS

CAUTION: The user reads a revision of the user manual that differs from their
software revision, so the user gets incorrect information on how to use the soft-
ware.

Extra work for user, since the software cannot be used.

e Ensure the version number of your Instructions for Use corresponds to
your software version number. The correct Instructions for Use for your
software can always be found under the Help menu, while the latest can
be found on the Medviso webpage.

CAUTION: Antivirus software has not been installed or updated.
Violation of patient integrity.

The computer where Segment is installed should have:

e Firewall,
e Anti-virus software installed and running,
e Back-up on patient data, and

e Personal login to access the software (in the preferences for Segment the
user can activate user login to the device and user logging for the usage
of the device.)

In the event that the use of Segment causes a serious incident, such that it
results in physical OR psychological harm to the user and/or patient, this shall
immediately be reported to Medviso AB (support@medviso.com), as well as
the competent authority of your Member State (Ministries/Agencies of Health
and/or Medicines).
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3 Installation guide

3.1 Installation and upgrading

To install or upgrade Segment, log in on our website (https://medviso.com/download2)/)
and download the installation file. Run the installation file under administrator privileges
on the machine and follow the instructions in the figures below. For assistance, please contact

support@medviso.com.

Segment Installation

Would you like to install Segment?

Figure 1: Click on Yes.

[ Ingtallation of Segment in progress.
Do NOT close this window!

L

2
LT3

completed)

WinZip Self-Extractor - Segment_Installer_4p0R11327 exe

(Thiz window will close automatically when installation is Cancel

About

Figure 2: The installation starts automatically.
automatically when the installation is completed.

Do not close this window, it will close
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3.1 - INSTALLATION AND UPGRADING

[] segment Installer - ] X
Connection Settings

Segment 3.07392
Software for Medical Image Analysis

Distributed by Medviso AB (http://www.medviso.com)

Medviso Development Team
support@medviso.com

Cancel

Figure 3: Click on Next.

@ Installation Options - m} X
Choose installation folder:
ChProgram Files\MedvisoSegment Browse...

Restore Default Folder

Add a shortcut to the desktop

Figure 4: Select Add a shortcut to the desktop. Click on Next.



3.1 - INSTALLATION AND UPGRADING

For first time installation, Matlab Compiler Runtime (MCR) needs to be installed according
to Figure 5] - [§] For upgrading, continue according to Figure [0

@\ Required Software — O X

MATLAB Runtime is required.

Choose installation folder: D ] !TLABV

C:\Program Files\MATLAB\MATLAB Runtime Browse...

R2019a

Restore Default Folder

MATLAB and Simulink are registered trademarks of The MathWorks, Inc. Please see
mathworks.com/trademarks for a list of additional trademarks. Other product or brand names may
be trademarks or registered trademarks of their respective holders.

WARNING: This program is protected by copyright law and international treaties. Copyright
1984-2019, The MathWorks, Inc. Protected by U.S. and other patents. See MathWorks.com/patents

) MatiWorks

Figure 5: Click on Next.

[ License Agreement — [m] X
The MathWorks, Inc. ~

MATLAB RUNTIME LICENSE

IMPORTANT NOTICE
BY CLICKING THE "YES" BUTTON BELOW, YOU ACCEPT THE TERMS OF THIS LICENSE. IF YOU ARE NOT WILLING TO DO SO,
SELECT THE "NO" BUTTON AND THE INSTALLATION WILL BE ABORTED.

1. LICENSE GRANT. Subject to the restrictions below, The MathWorks, Inc. ("MathWorks") hereby grants to you, whether
you are an individual or an entity, a license to install and use the MATLAB Runtime ("Runtime”), solely and expressly for the
purpose of running software created with the MATLAB Compiler (the "Application Software"), and for no other purpose.
This license is personal, nonexclusive, and nontransferable.

2. LICENSE RESTRICTIONS. You shall not modify or adapt the Runtime for any reason. You shall not disassemble,
decompile, or reverse engineer the Runtime. You shall not alter or remove any proprietary or other legal notices on or in
copies of the Runtime. Unless used to run Application Software, you shall not rent, lease, or loan the Runtime, time share
the Runtime, provide service bureau use, or use the Runtime for supporting any other party's use of the Runtime. You shall
not sublicense, sell, or otherwise transfer the Runtime to any third party. You shall not republish any documentation which
mav_bhe nrovided in cannsction with thae Runtima All rinhts nat arantsd_includina without limitation ricthts ta renradi

Do you accept the terms of the license agreement? (@) ye<

J Mathwo

Figure 6: Select Yes. Click on Next.



3.1 - INSTALLATION AND UPGRADING

\El Confirmation

Segment will be installed in:
C:\Program Files\Medviso\Segment

Segment requires MATLAB Runtime R201%a.

MATLAB Runtime R2019a will be installed in:
C:\Program Files\MATLAB\MATLAB Runtime\v96

Download Size: 1,588 MB

Cancel

Figure 7: Click on Install.

|§\ 25% Complete

Downloading ... (767 of 803 MB)
Download in progress...

I 25%

Pause

Figure 8: Wait for completed process.



3.1 - INSTALLATION AND UPGRADING

For upgrading, only install Segment according to Figure [J] -

%] Required Software - m} X

MATLAB Runtime is already installed in:
C:\Program Files\MATLAB\MATLAB Runtime

MATLAB

R2019a

MATLAB and Simulink are registered trademarks of The MathWaorks, Inc. Please see
mathworks.com/trademarks for a list of additional trademarks. Other product or brand names may
be trademarks or registered trademarks of their respective holders.

WARNIMG: This program is protected by copyright law and international treaties. Copyright
1984-2019, The MathWorks, Inc. Protected by U.5. and other patents. See MathWorks.com/patents

Figure 9: Click on Next.

[ Confirmation - ] X

Segment will be installed in:
C:\Program Files\Medvisa\Segment

Segment requires MATLAB Runtime R2019a.

MATLAB Runtime R2019a is already installed in:
C:\Program Files\MATLABYMATLAB Runtime'v6

Figure 10: Click on Install.




3.1 - INSTALLATION AND UPGRADING

For first time installation or upgrading, continue according to Figures [11] -

%] 38% Complete — m] *

Performing post-installation tasks. This may take a few moments...

T %%

Cancel

Figure 11: Wait for completed process.

@ Installation Complete

Installation completed successfully.

Product Configuration Motes:

To install special modules click under help menu and select Generate license option. You need
to run the software as administrater in erder to install additional medules. Right click on
software icon and select Run as Administrator.

Figure 12: Click on Finish.



3.2 - FIRST TIME RUNNING SEGMENT

3.2 First time running Segment

The first time you run the software to configure it you need to run the software as Admin-
istrator. Right click on the shortcut to the software and select Run as administrator. Note
that it is not sufficient to be logged in as administrator on the computer.

The first time Segment is started, it runs a setup process which can take a while, so be
patient. When starting the software, the image in Figure [13|should be displayed. If it is not
displayed, then the software is not correctly installed.

To complete the setup, set preferences and window positions as described in Sections [3.2.1

and

3.2.1 Setting preferences

It is recommended to set the preferences of which folders to use to avoid browsing each time

you want to load or save a file. It is invoked by using the icon (p). Set Data, Export

and CD folders.

3.2.2 Setting window positions

The position of the main window for Segment can be set by dragging the window to an
optional position and size. The size and position will be saved so that next time Segment
is launched the same position will be used. In case where one have switched to another
monitor, Segment may move outside the screen. In this case you could press Ctrl-0 to reset
GUI positions. This is also available under the File menu (a).

3.2.3 PACS connection

Setting up PACS connection and Segment Server usually requires help from your local PACS
support, and we recommend that you contact us to setup a telephone / web-based video con-
ference to make this process as smooth as possible. The Database and PACS connection
manual and the Sectra PACS plugin manual is found at Medviso AB homepage
(https://medviso.com /user-manuals). The Sectra PACS plugin may require additional Mi-
crosoft Visual C++ components that can be downloaded from Medviso AB homepage
(https:/ /medviso.com/download2/).

3.3 Add software license code

For new installations you need to add your license code for Segment. Add your license code
after installation by starting Segment and select Generate License under the Help menu in
Segment. Note that you have to run the software as Administrator to be able to add the li-
cense code in Segment. If you have lost the license code, please contact sales@medviso.com.
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3.4 - UNINSTALLATION

3.4 Uninstallation

4 License - x

MEDVISO

Welcome to Segment

Segment is freely avialable medical image
analysis software for research purposes.
provided that you cite relevant publications and
the usage of the software in your publications.

How to refer to Segment

You may NOT use this research version for
clinical routine, or any other commercial
applications including pharmaceutical trials paid
by industry. For clinical purposes Medviso
provides clinical software solutions.

Information about our software solutions are
found below.

About Segment CMR | About Strain module

Clinical s W Software for
W software for f cardiac strain
quantitative analysis in

% cing image

i cardiac MR s tagging and
image analysis "
stacks

About Segment 3DPrint ‘ About Segment CT

s> Clinical WG Cinical
~  software for MR software for
= 3D modeling quantitative
<z and 3D printing cardiac CT

L] imags anaysis

Figure 13: Startup window for Segment.

To uninstall Segment, go to Control Panel and select Uninstall a program (Figure [14). Search
for Segment in the programs list, right-click on it and select Uninstall/Change. Do the same
steps for uninstalling MATLAB Runtime, but select MATLAB Runtime in the programs

list.

User preferences are stored in AppData, in the subfolder Segment under each user account.

Centrol Panel

1+ » Control Panel

Review your computer's status
Save backup copies of your files with File

Back up and Restore (Windows 7)

/' Hardware and Sound
View devices and printers

Adjust commenly used mobility settings

Adjust your computer's settings

System and Security S& User Accounts

MNetwork and Internet

—
View network status and tasks e Clock and Reglon
‘/ Change date, time or number formats

Uninstall a program

&) Change account type

Appearance and Personalisation

Ease of Access
Let Windows suggest settings
Optimise visual display

Category *

Figure 14: Control Panel



3.5 - SOFTWARE OVERVIEW

3.5 Software overview
An overview of Segment is given in Figure
Mainmenu (a) Viewing panels (c) Undo Play (d) Screenshot view  Synchronize stacks

Adjust view (e) | Refresh Image Viewing preferences (f) Preferences (p)

|
Load (bl (G mprtoor w01 semmion T [ Ap—— o

Hide panels

modes (h)

Tool
palette (i)

LV,RV Quan-
tification (j)

Thumbnail
preview (o)
Volume
curve (k)

Flow Quan-
tification (1)

Flow
curve

N S (PO W S O S S | S SO, 18

Main viewing area (n)
Timebar

Figure 15: Main graphical user interface.

To learn more about each tool, hold the mouse over the icon in the software and a help text
will be displayed.

3.6 Software upgrade

When upgrading to new software version you can just install a new version over the old
version. The versions are always backwards compatible and settings are kept. If you have
activated services for Segment to work as a DICOM node, then these services need to be
stopped during the upgrade process. How to do this is illustrated in Figure The services
may also be stopped directly with Windows service manager by typing services.msc in the
Windows search box.

The services can be restarted after upgrade is complete. The services will also be automati-
cally restarted when the computer is restarted.

3.7 Trouble shooting

To trouble shoot the installation you can see if the Segment installation program actu-
ally was successfully started by checking for the existence of .log files. Segment cre-
ates a log file during installation, this file is stored in the user folder (i.e Documents and
Settings/Username and Application Data and the subfolder Segment. Note that this
folder by default is hidden. If you have problems installing Segment, please send this log-file



3.7 - TROUBLE SHOOTING

Database folder: & WManual Installtion of Segment Services

Report folder:

mporary folder: Servers are not running then go through steps 3 to 5

Ensure that so
Status

Segment Storage Server: Not installed

Segment Sorter Server:  Not installed

Sending DICOMS

Figure 16: Stop services button in the Manual Installation of Segment Services window.

to support@medviso.com together with a description on what problems where encountered.

In case the software runs then you can access the log-files under the Help menu and Open
Folder with Log Files

3.7.1 Segment fails to install

The most probable cause is not to run the installation software as administrator. Another
problem may be that have no Internet connection during installation.

3.7.2 Segment fails to start after installation

If the software fails to start after installation without or with error messages, that means that
the installation process was not completed successfully Please refer to the section "Program
won’t start" in our FAQ (www.medviso.com/faq) for further support.

3.7.3 No compatible GPU configuration detected

Segment fails to find a compatible NVIDIA graphics card. Firstly check that the card is
correctly installed and meet the performance. We recommend to download the tool GPU-Z
from Techpowerup for this purpose (www.techpowerup.com/download/techpowerup-gpu-z).
If you have one card installed that should match the requirements on possible cause may be
that your operating system is blocking GPU usage either for compability reasons or power
saving reasons.
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3.7 - TROUBLE SHOOTING

Mew

L 1 Display settings

K2 Personalize

Figure 17: Select display settings by right click on desktop.

Settings - a X

G Home Display

Y 5 | Scale and layout

Change the size of text, apps, and other items
System

100% v
3 Display Advanced scaling settings
4 Sound Display resolution
1920 x 1080 (Recommended) hd
] Notifications & actions R
Display orientation
Focus assist Landscape ~
(5 Power & sleep .
Multiple displays
L L Multiple displays
= Storage Extend these displays v
B Tablet |:| Make this my main display

=1 Multitasking Connect to a wireless display

Advanced display settings
& Projecting to this PC
% Shared experiences

[ Clinhoard

Figure 18: Select Graphics settings.

3.7.4 Sudden software crash

This is most likely caused by old NVIDIA graphics driver, please see Section [3.7.5] For
getting help general crashes please send log-files to support@medviso.com. See details on
where to

3.7.5 Update NVIDIA graphics driver to latest version

Please note that although you use Windows update and this process claims all drivers to be
updated this is likely not the case for the NVIDIA graphics card driver. To install a new
version, go to http://nvidia.co.uk/Download/index.aspx. Select you graphics card details
and press Search. Follow instructions on how to download and install. See also under
Section B.7.3] on how to see GPU details and driver version details.
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3.7 - TROUBLE SHOOTING

« Settings - O
& Graphics settings

Hardware-accelerated GPU scheduling

Reduce latency and improve performance. You'll need to restart
your PC to have your changes take effect.

@ o

Graphics performance preference

Choose between better performance or battery life when using an
app. You might need to restart the app for your changes to take
effect.

Choose an app to set preference

Desktop app w

Browse

Segment3DPrint.exe

High performance

Figure 19: Select Browse, and select folder where Segment is installed. Select application.

Select High Performance.
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